
Grade:          Teacher’s Signature: 

WORKSHEET 1

 

c
la

ss
 6

Name: 

Roll No: 

Class:  Section:  Date: 

T uchpad
PLUS Ver. 3.2

A.	 Guess! Who am I? 

1.	 I am used to adjust the volume of the microphone attached  
to the computer system. � …………………

2.	 I am a long bar present below the Title bar of an application window. � …………………

3.	 I am a bar that is displayed at the left edge of the monitor. � …………………

4.	 I am used to change the colour scheme of the application windows. � …………………

B.	 Write `T’ for true and `F’ for false. 

1.	 Background is used to change the appearance of the desktop. � ………….

2.	 Long horizontal bar on the right side of the desktop is called Dock.� ………….

3.	 Minimize button is used to maximize or enlarge the active application  
window to fill the whole screen. � ………….

4.	 Multitasking is used to install or uninstall programs and software on  
the computer.  � ………….

C.	 Label the following components of an Application window:

ADVANCED FEATURES OF UBUNTU
Chapter-1
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A.	 Tick ( ) the correct option.
1.	 Which of the following is the actual area of a program where you can work? 

	 a.	 Menu bar 	 	 b.	 Work Area	

	 c.	 Status bar	 	 d.	 Title bar	

2.	 Which of the following is used to change the appearance of the application windows?

	 a.	 Sound 	 	 b.	 Background	

	 c.	 Displays 	 	 d.	 Multitasking  	

3.	 ……………………… is used to extend or mirror your desktop across multiple screens.  

	 a.	 Programs 	 	 b.	 Multitasking	

	 c.	 Sound 	 	 d.	 Displays	

B.	 Define the following:

1.	 Menu Bar- ……………………………………………………………………………………

	 …………………………………………….…………………………………………………

2.	 Title Bar- ……………………………………………………………………………………

	 …………………………………………….…………………………………………………

3.	 Control Buttons-  ………………………………………………………………………...…

	 …………………………………………….…………………………………………………

C.	 Write the steps to open the Settings Window.

Step 1: ………………………………………………………………………………………

Step 2: ………………………………………………………………………………………

ADVANCED FEATURES OF UBUNTU
Chapter-1
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A.	 Circle the correct option.

1.	 A presentation is made up of several (slides / pages).

2.	 (Impress / Writer) is a very useful software application  which is used to create electronic  
presentations.

3.	 A (template / slide) is a set of predefined layouts that can be used to add a professional 
touch to your presentation.

4.	 Video option is present under the (Insert / File) menu.

5.	 You (can / cannot) customize the existing templates or build your own templates.

B.	 Complete the sentences.

1.	 Slide Transition determines how your presentation moves from …………………… .

2.	 Animations are used in Impress to make a presentation more  ………………… .

3.	 The Slide Show menu will let you set up how your show will …………………… .

4.	 You can also add audio files in your …………………… .

5.	 Slides can be run one after the other to form a …………………… .

C.	 Number the steps to add video to the presentation.

	� Navigate and select the video file to be inserted and click on the Open button. This 

will insert a media icon on the slide. 

	 Click on the Insert menu. 

	� Click on the  button in the Media Playback section of Properties panel to 
preview the video. 

	 Select the Audio or Video option. The Insert Audio or Video dialog box appears. 

MORE ON LIBREOFFICE IMPRESS
Chapter-2



Grade:          Teacher’s Signature: 

WORKSHEET 2

 

c
la

ss
 6

Name: 

Roll No: 

Class:  Section:  Date: 

T uchpad
PLUS Ver. 3.2

A.	 Tick ( ) the correct option.

1.	 Which of the following menus is used to add transition to a presentation? 

	 a.	 File  	 	 b.	 Edit	

	 c.	 Slide 	 	 d.	 View	

2.	 Which of the following options is used to start slide show from the beginning?

	 a.	 Start from First Slide  	 	 b.	 Start from Current Slide 	

	 c.	 Start from End Slide 	 	 d.	 None of these 	

3.	 ………………… helps in giving a moving effect to the text and other objects on a slide.

	 a.	 Transition 	 	 b.	 Template	

	 c.	 Animation 	 	 d.	 Slide Show 	

B.	 Define the following:
1.	 Presentation - ………………………………………………………………………………

	 	………………………………………………………………………………………………

2.	 Animation - …………………………………………………………………………………

	 ………………………………………………………………………………………………

3.	 Slide Transition - ……………………………………………………………………………

	 ………………………………………………………………………………………………

C.	 Guess! Who am I? 

1. 	 I am the option used to start the slide show from the current slide. � …………………

2. 	 I am the menu that contains the Audio option. � …………………

3.	 I am used to add professional touch to the presentations.  � …………………

MORE ON LIBREOFFICE IMPRESS
Chapter-2
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A.	 Circle the correct option.

1.	 In Writer, formatting refers to the (appearance / background) of a document.

2.	 We (can / cannot) find a word or phrase in a document.

3.	 (Line / Paragraph) spacing is the blank space between two lines in a paragraph.

4.	 Page (margin / orientation) is the white space all around the printed area of the paper.

5.	 A faded text or image behind the text on each page is called a (watermark/background).

B.	 Complete the sentences.

1.	 ……………… is the text that appears at the top of each page of the document. 

2.	 ……………… is the text like page number that appears at the bottom of the each page.

3.	 We can set the page orientation from the  ………………… option. 

4.	 We can use Watermark option from ………………… menu. 

5.	 After you close the header or footer, it will still be visible, but it will be ………………… .

C.	 Define the following:

1.	 Mail Merge - …………………………………………………………………………………

	 ………………………………………………………………………………………………

2.	 Page Orientation -…………………………………………………………………………

	 ………………………………………………………………………………………………

3.	 Paragraph Spacing - …………………………………………………………………………

	 ………………………………………………………………………………………………

MORE ON WRITER
Chapter-3
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A.	 Tick ( ) the correct option.
1.	 What should you set the angle to if you want the watermark to appear diagonally across 

the page? 

	 a.	 0 	 	 b.	 49	

	 c.	 90	 	 d.	 180	

2.	 Which of the following options is used to insert an equation in Writer?

	 a.	 Symbol	 	 b.	 Object	

	 c.	 Equation	 	 d.	 None of these	

3.	 In which menu Header option is found?

	 a.	 File 	 	 b.	 Edit	

	 c.	 Tools 	 	 d.	 Insert	

4.	 Which menu is used to insert the date or time into a header or footer?

	 a.	 Format 	 	 b.	 Insert	

	 c.	 View 	 	 d.	 Tools	

5.	 Which button should you click to replace all occurrences of a word with a new word?

	 a.	 Replace 	 	 b.	 Find Next	

	 c.	 Find All 	 	 d.	 Replace All	

B.	 Write the steps to set the page margins.
Step 1:	 ……………………………………………………………………………………………

Step 2:	 ……………………………………………………………………………………………

Step 3:	 ……………………………………………………………………………………………

Step 4:	 ……………………………………………………………………………………………

MORE ON WRITER
Chapter-3
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A.	 Define the following:

1.	 Formula Bar- …………………………………………………………………………………

	 ………………………………………………………………………………………………

2.	 Cell - …………………………………………………………………………………………

	 ………………………………………………………………………………………………

3.	 Workbook - …………………………………………………………………………………

	 ………………………………………………………………………………………………

B.	 Label the following components of LibreOffice Calc: 

Cell

Column Heading

 

MORE ON LIBREOFFICE CALC
Chapter-4



Grade:          Teacher’s Signature: 

WORKSHEET 2

 

c
la

ss
 6

Name: 

Roll No: 

Class:  Section:  Date: 

T uchpad
PLUS Ver. 3.2

A.	 Tick ( ) the correct option.
1.	 The currently selected cell that appears highlighted with dark black border is 

called ………………………. . 

	 a.	 Active Cell	 	 b.	 Selected Cell	

	 c.	 Main Cell	 	 d.	 Name Box	

2.	 By default, how many worksheets are there in a Workbook?

	 a.	 2	 	 b.	 4	

	 c.	 3	 	 d.	 1 	

3.	 Total number of rows in a worksheet are ………………………. . 

	 a.	 10,48,576  	 	 b.	 1,48,576 	

	 c.	 16,384 	 	 d.	 7,19,347 	

4.	 Which menu is used to create a new workbook in LibreOffice Calc?

	 a.	 Edit 	 	 b.	 View	

	 c.	 File	 	 d.	 Insert	

5.	  In which tab can you find the options to set cell borders?

	 a.	 General 	 	 b.	 Borders	

	 c.	 Font	 	 d.	 Alignment	

B.	 Complete the sentences.

1.		 A cell in Calc worksheet looks like a ………………………. .

2.	 Address of an active cell is displayed in the ………………………. .

3.	 Calc allows you to merge multiple cells to make a single ………………………. .

4. 	 The default column width is ………………………. .

MORE ON LIBREOFFICE CALC
Chapter-4
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A.	 Tick ( ) the correct option.
1.	 Which of the following is an example of an empty HTML tag?

	 a.	 <head>	 	 b.	 <br>	

	 c.	 <h1>	 	 d.	 <body>	

2.	 Which of the following is the correct syntax for the <title> tag?

	 a.	 <title>My Web Page</title>	 	 b.	 <title>My Web Page>	

	 c.	 <title="My Web Page">	 	 d.	 <Title/>My Web Page<Title>	

B.	 Write `T’ for true and `F’ for false.

1.		 The <body> tag contains the main content of the webpage.� ………………………. .

2.	 An attribute is a property that provides additional information  
about a tag.� ………………………. .

3.	 HTML is a programming language.� ………………………. .

4.	 Nesting of tags means that you can start a new tag before  
closing the previous tag.� ………………………. .

5.	 The text level tags take up the full width available and by  
default begin on a new line.� ………………………. .

B.	 Define the following:

1.	 Internal Style Sheet- ………………………………………………………………………

2.	 External Style Sheet- ………………………………………………………………………

3.	 Container Tags- ……………………………………………………………………………

C.	 Write the steps to edit an existing HTML document.

Step 1:	 ……………………………………………………………………………………………

Step 2:	 ……………………………………………………………………………………………

Step 3:	 ……………………………………………………………………………………………

INTRODUCTION TO HTML5 & CSS3
Chapter-5
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A.	 Complete the basic structure of HTML document. 
…………………

<html> 

…………………

<title>Title of the web page</title> 

</head> 

<body> 

Content of the page 

…………………

…………………

B.	 Write `T’ for true and `F’ for false.

1.	 Empty tags contain only an ………………………. tag.

2.	 An HTML document is a text file containing ………………………. tags.

3.	 Body contains the information which is to be shown on the ………………………..

4.	 The <head> tag defines the ………………………. area of your web page.

5.	 After creating and saving an HTML document, you need to open it in a ………………………. 
to view it.

C.	 Write the full forms of the following:

1.	 HTML- ………………………………………………………………………………………

2.	 WYSIWYG- …………………………………………………………………………………

3.	 CSS- …………………………………………………………………………………………

4.	 URL- …………………………………………………………………………………………

INTRODUCTION TO HTML5 & CSS3
Chapter-5
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A.	 Label the following components of the Tupi 2D window:

B.	 Answer the following questions:
1.	 Which option is used to create a new Tupi 2D project?

	 ………………………………………………………………………………………

2. 	 What is the use of News Module? 

	 ………………………………………………………………………………………

C.	 Define the following:
1.	 Toolbox- ……………………………………………………………………………………

………………………………………………………………………………………………

2.	 Color Palette- ……………………………………………………………………………
………………………………………………………………………………………………

INTRODUCTION TO TUPI 2D
Chapter-6
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A.	 Identify the following tools and write their names:

		  		  		

1.	 ……………………	 2.	 ……………………	 3.		  ……………………

B.	 Tick ( ) the correct option.

1.	 Which of the following panel is used to import images directly to the workspace.

	 a.	 Library 	 	 b.	 Color Palette 	

	 c.	 Expanded Panel  	 	 d.	 Scenes Manager 	

2.	 ……………… is the main working area where we create, design and create animations.  

	 a.	 Workspace 	 	 b.	 Menu Bar 	

	 c.	 Toolbar 	 	 d.	 Toolbox  	

3.	 Which of the following components of the Tupi 2D has the color palette? 

	 a.	 Left side bar	 	 b.	 Right side bar	

	 c.	 Bottom side bar	 	 d.	 Exposure sheet	

4.	 Which of the following options is used to exit the Tupi 2D window? 

	 a.	 File → Quit	 	 b.	 File → Exit	

	 c.	 File → Close	 	 d.	 None of these	

B.	 Number the steps to save a Tupi 2D project.

	 Click on Save Project option. The Save Project As dialog box appears.

	 Click on the File menu.

	 Click on the Save button.

		 Enter a name for the project in the File name text box.

INTRODUCTION TO TUPI 2D
Chapter-6
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A.	 Tick ( ) the correct option.
1.	 Which of the following is a popular video conferencing tool?

	 a.	 WhatsApp	 	 b.	 Google Meet

	 c.	 Telegram	 	 d.	 WeChat

2.	 Which of these is an example of a cyber threat?

	 a.	 VoIP	 	 b.	 Data Diddling

	 c.	 Video Conferencing	 	 d.	 Social Networking

3.	 Which of these is a service where data is stored remotely on a server?

	 a.	 Cloud storage	 	 b.	 E-greetings

	 c.	 ATM	 	 d.	 VoIP

4.	 Software cracking is considered illegal and cracked software is often called ………………. 

	 a.	 Custom Software	 	 b.	 Pirated Software 

	 c.	 Genuine Software	 	 d.	 None of these

B.	 Write the full form of the following: 

1.	 VoIP - ………………………………………………………………………………………

2.	 E-mail -  ……………………………………………………………………………………

C.	 Complete the sentences:

1.	 Netiquette refers to the proper and polite way to ……………… online.

2. 	 A cyber threat is a ……………… activity in which computers are used to damage or steal 
data.

3.	 ………………  is crucial for modern information systems.

INTERNET SERVICES AND CYBER CRIME
Chapter-7
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INTERNET SERVICES AND CYBER CRIME
Chapter-7

A.	 Write a short note on the following: 

1.	 Chatting- ……………………………………………………………………………………

	 ………………………………………………………………………………………………

2.	 Newsgroup - …………………………………………………………………………………

	 ………………………………………………………………………………………………

3.	 E-Banking - …………………………………………………………………………………

	 ………………………………………………………………………………………………

B.	 Write `T’ for true and `F’ for false.

1.	 An e-greeting is like a paper greeting card, but it is made using digital  
text and effects.� ……………

2.	 Always share personal information such as your address, phone  
number, or school details.� ……………

3.	 Computer hacking involves altering computer hardware and software  
to achieve goals beyond their original design.� ……………

4.	 The Internet is a global network that can be accessed from anywhere  
in the world.� ……………

5.	 Cybersecurity involves protecting computer resources, including  
networks, devices, programs, and data, from unauthorised access,  
damage, or attacks. � ……………

C.	 Write one example of each of the following:

1.	 Cloud Storage Service - …………………………………… 

2.	 E-Greetings Website - …………………………………… 

3.	 Social Networking Service- …………………………………… 

4.	 Chatting Service-
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A.	 Complete the flowchart to calculate the simple interest. 

Read P for Principal
         r for rate
         t for time

Stop

Start

B.	 Write ‘T’ for true and ‘F’ for false.

1.	 Algorithm uses various symbols to shows the process flow of the program.	 ………….

2.	 In flowcharts, decision box is used to show the branches in the process flow.	 ………….

3.	 Algorithm and flowchart are the same thing. 			   ………….

4.	 Flowcharts show the sequence of instructions in a single program.	 ………….

5.	 A set of geometrical boxes represents the steps involved in the solution process. 

C.	 Write an algorithm to calculate the factorial of a number.  

	 ………………………………………………………………………………………

	 ………………………………………………………………………………………

	 ………………………………………………………………………………………

	 ………………………………………………………………………………………

	 ………………………………………………………………………………………

ALGORITHM AND FLOWCHART
Chapter-8
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A.	 Write an algorithm to find the smallest in two numbers A and B. 
……………………………………………………………………………………………

……………………………………………………………………………………………

……………………………………………………………………………………………

……………………………………………………………………………………………

……………………………………………………………………………………………

B.	 Tick ( ) the correct option.
1.	 In a flowchart, process box is represented by a …………………… symbol.

	 a.	 Triangle	 	 b.	 Rectangle	

	 c.	 Square	 	 d.	 Line	

2.	 A flowchart is a graphical representation of a/an …………………… .

	 a.	 program	 	 b.	 algorithm	

	 c.	 symbol	 	 d.	 none of these	

3.	 …………………… is another name for flow lines.

	 a.	 Connectors	 	 b.	 Start box	

	 c.	 Decision box	 	 d.	 Medium	

C.	 Draw a flowchart to check if a number is positive or negative.
	

ALGORITHM AND FLOWCHART
Chapter-8
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A.	 Tick ( ) the correct option.
1.	 Which one of the following is not an arithmetic operator used in Python? 

	 a.	 Addition	 	 b.	 Multiplication 	

	 c.	 Exponentiation 	 	 d.	 Parentheses 	

2.	 Which of the following functions is used to take input from the user in Python? 

	 a.	 input()	 	 b.	 print() 	

	 c.	 float() 	 	 d.	 str() 	

3.	 Which mode in Python executes commands line by line and gives immediate results? 

	 a.	 Script Mode	 	 b.	 Batch Mode 	

	 c.	 Interactive Mode	 	 d.	 Debugging Mode 	

4.	 Which of the following is not a valid variable name in Python? 

	 a.	 student_name 	 	 b.	 _age 	

	 c.	 1st_name	 	 d.	 total_score 	

5.	 What will be the output of the following expression: 98% 3 

	 a.	 7 	 	 b.	 2 	

	 c.	 0 	 	 d.	 5	

B.	 Identify the components of Python IDLE window and write down the names in the 
given boxes.

INTRODUCTION TO PYTHON
Chapter-9
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A.	 Guess! who am I?
1.	 I am an operator used to assign the value of the right expression to the  

left operand.� ……………

2.	 I am an operator used to perform addition between two operands. � ……………

3.	 I am an operator that returns true, if one of the operands is true. � ……………

B.	 Write ‘T’ for true and ‘F’ for false. 

1.	 The print() function allows to display output on the screen while a  
program executes. � ……………

2.	 The relational operators are used primarily in the expression evaluation to  
make a decision.� ……………

3.	 The input() function automatically converts input data to the correct  
data type. � ……………

4.	 In Python, a variable can store multiple types of data, including strings,  
integers, and floats. � ……………

C.	 Write ‘T’ for true and ‘F’ for false. 

1.	 a = 10  	

	 b = 5  

	 result = a ** b  

	 print("The result of", a, "raised to the power of", b, "is", result)

2.	 a = 10  

	 b = 5  

	 a = a + b  

	 b = a - b  

	 a = a - b  

	 print("a:", a, "b:", b)

INTRODUCTION TO PYTHON
Chapter-9
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A.	 Tick ( ) the correct option.
1. 	 Which quality do people with musical intelligence possess?  

	 a.	 Love singing  	 	 b.	 Recognise musical patterns�  

	 c.	 Both a and b  	 	 d.	 None of these�

2. 	 Which quality do people with intrapersonal intelligence  possess?  

	 a.	 Can recognise their strengths	 	 b.	 Nature lover�

	 c.	 Both a and b  	 	 d.	 None of these�

3. 	 Which of the following is not  a type of intelligence according to Howard Gardner?

	 a.	 Verbal-Linguistic Intelligence	 	 b.	 Existential Intelligence�

	 c. 	 Musical Intelligence	 	 d.	 Approach Intelligence�

B. 	 Read the given clues and identify the type of intelligence following people posses.

1.	 I am good at problem-solving and i love thinking about abstract ideas. � ………………

2.	 I am flexible in different body movements and performing actions.� ………………

3.	 I am good at maintaining positive relationships with others.� ………………

4.	 I can remember written and spoken information.� ………………

C. 	 Answer the following questions: 

1. 	 What do you mean by naturalistic intelligence?

	 ………….………….………….………….………….………….………….…………

	 ………….………….………….………….………….………….………….…………

2. 	 Define learning-based approach. 

	 ………….………….………….………….………….………….………….…………

	 ………….………….………….………….………….………….………….…………

INTELLIGENCE AND AI APPROACHES
Chapter-10
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A.	 Fill in the blanks using the hints given below.

Hints: �Machine learning,  Learning-based approach, Bodily-Kinesthetic, interpersonal, 
knowledge 

1.	 Good at communicating ideas and thoughts is a quality of people with …………………. 
intelligence. 

2. 	 Rule-based system uses the …………………. of a human expert in a specialised domain.

3. 	 …………………. is a subset of AI.

4. 	 …………..…. is often referred to as a black box because it is not entirely clear how these 
systems take decisions.   

5. 	 Excellent hand-eye and physical coordination is a quality of people with ……………. 
intelligence.

B. 	 Write ‘T’ for true and ‘F’ for false.
1. 	 People with interpersonal intelligence are good at singing and � …………. 

playing musical instruments.  

2. 	 A rule-based system uses rules as knowledge representation. � …………. 

3. 	 Machine learning is not a way of achieving AI. � …………. 

4. 	 Nature lover is an example of existential intelligence. � …………. 

5. 	 The aim of AI is to simulate the human attributes such as logical intelligence, reasoning 
and knowledge acquirement in machines. � ………….

C.	 Match the following:
1.	 Existential Intelligence	 a.	 Use humour while telling stories.

2. 	 Visual-Spatial Intelligence	 b.	 Recognise musical patterns and tones easily. 

3. 	 Verbal-Linguistic Intelligence 	 c.	 Good at putting puzzles together. 

4. 	 Musical Intelligence 	 d.	 Look at things from different point of view. 

5. 	 Intrapersonal Intelligence	 e.	 Enjoy analysing theories and ideas.

INTELLIGENCE AND AI APPROACHES
Chapter-10


